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Introduction 
Many industrial operations, such as plants and factories, generate large amounts of data. It is often 

necessary to keep a historical record of this data. Trending, cost analysis and safety auditing are 

common reasons to keep historical data. 

It is common practice to store historical data in a database management system. Many database 

vendors provide access to their databases using the Open Database Connectivity (ODBC) standard. 

This standard allows a user to interact with the database using the Structured Query Language 

(SQL). The MatrikonOPC Client for ODBC provides custom functionality for transporting OPC data to 

and from an ODBC data source. Using the graphical configuration tool, basic functionally to insert 

and update OPC information in a database can be configured without specific knowledge of SQL. 

This software also allows a user to formulate custom queries using a combination of the SQL, and 

data tags from the OPC data source. 

The ODBC Client can be used for any application that requires DA OPC data to be stored in an 

ODBC database. Examples of industries which may benefit from ODBC Client include but are not 

limited to, Manufacturing, Oil and Gas, and Pulp and Paper. 

Who Should Use This Manual 
This manual is intended for use by all users of the MatrikonOPC Client for ODBC.  

This manual explains how to install and configure the software, and how to perform common tasks. 

In addition, technical information about OPC data items is included, along with sections on 

diagnostics and troubleshooting. 

Overview of Manual 
This document uses icons to highlight valuable information and assists the user throughout the 

manual. 

 

This symbol denotes important information that must be 

acknowledged. Failure to do so may result in the software not 

functioning properly. 

BOLD 

Font displayed in this color and style indicates a hyperlink to the 

applicable/associated information within this document, or if 

applicable, any external sources. 

 

The User’s Manual has been designed in such a way that the user can click on references in the 

document to jump to that referenced point without having to scroll through several pages (in some 

cases). For example, if the user requires to see the sentence “Refer to Figure 1 for more 

information”, press the CTRL key and click the mouse on the text “Figure 1” which will 

automatically take the user to the location of Figure 1 within the document. 

This manual consists of several sections and is structured as follows: 

 Introduction – this is an introductory chapter. 

 Getting Started – provides instructions for installing the client, and how to contact 

Matrikon OPC’s Support team. 

 Configuration – depicts how to start and configure the client, and describes each 

component in detail, including windows/screens, panels, tabs, and menu commands. 
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 Diagnostics – explains how to use logging, statistical items, data qualities, timestamps, 

and result codes to get the most efficiency from the user’s system. 

 Limitations – provides information on specific performance and operational limitations of 

the software. 

 Troubleshooting – provides solutions for common problems that may be encountered, and 

answers to frequently asked questions. 

 Un-installation – provides instructions on un-installing software. 

 OPC Compliance – details on the OPC standard the client uses for communication. 

 Appendices: 

 A – Distributed COM (DCOM) 

 B – ODBC DSN Configuration 

References 
This document references information found within the following documents/sites: 

 www.opcfoundation.org 

 www.MatrikonOPC.com  

 www.opcsupport.com  

Document Terminology 
The terms screen and window are used interchangeably throughout this document. 

Table 1 provides a list of definitions for terms used throughout this document.  

Term/Abbreviation Description 

COM 
Component Object Model. A method for organizing software, specifying how to 

build components that can be dynamically interchanged. 

DA OPC Data Access. Provides access to real-time process data. 

DCOM 
Distributed Component Object Model. An extension of COM that allows 

communication between COM components over a network. 

HMI 
Human Machine Interface. Device that allows interaction between the user and 

machine. Typically used in process control applications. 

Matrikon Matrikon Inc. 

Matrikon OPC Matrikon’s brand name for its OPC servers and clients. 

OPC 
A communication standard. Refer to www.opcfoundation.org for more 

information. 

PLC Programmable Logic Controller. 

ODBC 
Open Database Connectivity. A standard defining a method for applications to 

interact with compliant databases.  

Table 1 - Terms and Definitions 

http://www.opcfoundation.org/
http://www.matrikonopc.com/
http://www.opcsupport.com/
http://www.opcfoundation.org/
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Getting Started 
This chapter contains important information about installing the client and how to contact 

Matrikon’s Support team. 

The System Requirements section shows how to avoid future problems by ensuring that the 

system meets the minimum software and hardware requirements. Detailed step-by-step 

instructions in the Installation section walks the user through the installation process and lists the 

files that are installed during this process. 

Once the client has been installed, refer to the Licensing Procedures document that was installed 

along with the client and this User’s Manual, to learn how to obtain the appropriate license. If any 

problems are encountered during installation or licensing, refer to the Contacting Support section 

for information about how to contact the Matrikon OPC Support team for assistance. 

System Requirements 
The software has minimum Software and Hardware system requirements. These requirements 

must be met for the software to function properly. 

 

Note:  

The user must have an administrative user account rather than a restricted user account 

to install and configure a Matrikon OPC product. 

Software Requirements 

 

The MatrikonOPC Client for ODBC requires the following software: 

Operating System 

 Microsoft Windows 10 or  

 Microsoft Windows 2016 Server or   

 Microsoft Windows 2012 R2 Server or   

 Microsoft Windows 7 32Bit or 

 Microsoft Windows 7 64Bit or 

 Microsoft Windows Server 2008 R2 64Bit 

 

 

Note:  

It is recommended that the most current service packs are installed. The above listed OS 

along with service packs have been tested for MatrikonOPC Client for ODBC compatibility. 

 

Additional Software Requirements 

 Microsoft Visual C++2008 Runtime 

 Microsoft .NET Framework 3.5 

Hardware Requirements 

The minimum hardware required for Matrikon Client for ODBC are mentioned below: 



 

 MatrikonOPC Client for ODBC User’s Manual  12 

 Intel® CORE i5 

 4 GB RAM  

 80 GB 7200 RPM Hard Drive 
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Installation 
Once the system requirements have been met, the user is ready to install the software. 

 

Note:  

 If the user already has an instance of MatrikonOPC Client for ODBC installed on the 

machine, the user must completely un-install the old ODBC client before 

installing the new one. If the user attempts to install one instance on top of 

another, a re-install requires to be performed. 

 As part of the installation process, the Matrikon OPC Analyzer tool is installed 

and used to detect the system settings that affect the use of this software. No 

information is communicated back to Matrikon. Information is stored on this 

system only for future use by Matrikon OPC Support to assist with troubleshooting, 

if required. 

Perform the following steps to install the software: 

1. Insert the MatrikonOPC Client for ODBC CD into the CD drive. 

2. Double-click the Matrikon OPCODBCClient.EXE file, if the Matrikon OPC InstallAware screen 

does not automatically appear. The InstallAware Wizard (Figure 1) verifies its contents. 

 

 

Figure 1 – InstallAware Wizard 

Either a Prerequisites screen appears, or the user is taken directly to the Licensing 

Agreement screen. If the Licensing Agreement screen is the displayed screen, go to step 

4.  

3. Click on the Next button to install the listed pre-requisites, if the Prerequisites screen 

appears.  

     After all the prerequisites, have been installed, the License Agreement screen (Figure 2) 

appears.  

 

 

     Note:  

From the License Agreement screen, the user has the option of selecting the I 

reject the license agreement option. Selecting the I reject the license agreement 

option button disables the Next button so the options are to return to the previous 

screen, cancel the install by clicking on the Cancel button, or select the I accept the 

license agreement option button to proceed through the installation. 
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Figure 2 – License Agreement screen 

4. Read the Software License Agreement, using the scroll bar to view the entire message.  

5. Select the I accept the license agreement option button.  

6. Click on the Next button. The Setup Type screen (Figure 3) appears.  
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Figure 3 – Setup Type screen 

7. Select the type of setup to be performed.  

If Express Setup is selected the Server will get installed with default options mentioned in 

Setup Type Screen (Figure 3) and the user will not see Step 9 to Step 15. 

 
If Custom Setup is selected, the user will get the option to customize the installation. 

 

 

     Note:  

Matrikon OPC recommends the user to select the Express Setup option. 

 

8. Select Custom Setup and Click on the Next button. The Select Features Screen (Figure 4) 

appears. 
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Figure 4 – Select Features screen 

9. Click on the Next button. The Destination Folder screen (Figure 5) appears.  
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Figure 5 – Destination Folder screen 

10. Select the folder in which MatrikonOPC Client for ODBC must be installed, or accept the 

default location displayed in the Folder path field. 

11. Click on the Next button. The Start Menu screen (Figure 6) appears. 
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Figure 6 – Start Menu screen 

12. Select the Start Menu group and the user specifies whether the shortcuts requires to be 

created only for yourself, or for all users, by selecting the applicable option button.  

 

 

 Note:  

 The default password provided for the user is Matrikon OPC. Note this password for    

 future references. 

 

13. Click on the Next button to accept the default password. The Licensing screen (Figure 7) 

appears.  
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Figure 7 – Licensing screen 

14. Select the applicable licensing option.  

15. Click on the Next button. The Ready to Install screen (Figure 8) appears.  
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Figure 8 – Ready to Install screen 

16. Click the Next button. The Installing MatrikonOPC Client for ODBC screen (Figure 9) 

appears, installation begins, and the product files are copied to the computer.  

 

 

Note:  

Prior to starting the installation, the user has the option of clicking on the Back button to 

change any of the installation information. Click the Cancel button if the user wishes to 

stop or cancel the installation. 
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Figure 9 – Installing MatrikonOPC Client for ODBC screen 

Once the installation is complete, the MatrikonOPC Client for ODBC Setup Complete 

screen (Figure 10) appears stating that the Matrikon OPC server has been successfully 

installed.  
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Figure 10 – MatrikonOPC Client for ODBC Setup Complete screen 

17. Launch any or all the following features by selecting the necessary checkbox or checkboxes:  

 Configuration Panel  

 Release Notes 

 User Manual 

 Configuration Video 

18. Click the Finish button to complete the installation and exit the Wizard.  

The necessary files are now been copied to the target computer, the software components 

are registered, and shortcut icons are created in the Start menu. 

 

 

Note:  

At this point, it is recommended that the user verifies the DCOM settings. Reference to the 

DCOM configuration can be found in the DCOM Manual. This configuration varies for 

different operating systems. 

 

 

 

 

  

http://opcsupport.com/link/portal/4164/4590/Article/885/DCOM-Configuration
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Installed Files 
The installation program copies all necessary files to the target computer and creates shortcut 

icons in the Start menu. 

The files listed in Table 2 are installed by default, in the following location: 

C:\Program Files\Matrikon\OPC\OPC ODBC 

File Name Description 

GDAODBC.dll Dynamic link library used for ODBC connectivity. 

LogLibrary.dll Log library file. 

MatrikonOPC Client for ODBC 

Release Notes.pdf 
Release Notes for the client. 

MatrikonOPC Client for ODBC 

User Manual.pdf 
This User’s Manual for the client. 

Moces.log ODBC client GUI log. 

OdbcClient.xsd 

An XML schema definition for the configuration files used for the 

ODBC Client. This file is necessary to validate that configuration 

files are correct upon load. 

ODBCClientConfiguration.wmv A tutorial video to configure the OPC Client for ODBC. 

ODBCOPCCLIENT.exe Client executable. 

OdbcOpcClientGui.exe Graphical client configuration executable. 

ODBCOPCCLIENTps.dll The interface library between the GUI and the client. 

ODBCOPCCLient.log ODBC Client log file. 

SampleDB.mdb Sample database. 

SampleMTKConfig.xml Sample configuration loaded on start-up. 

Table 2 - Files Installed in "OPC ODBC" Folder 

The files listed in Table 3 are installed by default, in the following location:  

C:\Program Files\Common Files\Matrikon OPC\Common 

File Name Description 

EULA.pdf License document. 

MTKAUTHORIZE.EXE Matrikon product authorization utility. 

OPCAuto.dll 
Matrikon OPC Automation Component – enables developers to access OPC 

data from client applications developed using Automation tools. 

OPCDA20_AUTO.DOC Matrikon OPC Automation Component interface standard. 

OPCDAAUTO.DLL 

Matrikon OPC Automation Component – enables developers to access OPC 

data from client applications developed using automation tools (e.g., 

Visual Basic, VBA, VB Script). 

opchda_ps.dll 
The proxy-stub files to allow OPC clients to make remote connections to 

an OPC HDA Server.  
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File Name Description 

opchda10_auto.doc Developer documentation for HDA Automation Component. 

OPCHDAAuto.dll 

Matrikon OPC HDA Automation Component – enables developers to 

access OPC HDA Data from client applications developed using 

Automation tools. 

PSTCFG.EXE Matrikon product configuration utility. 

PSTCFGPS.DLL Matrikon product configuration marshaling library. 

EULA.pdf End-User License Agreement in PDF format. 

Hasp.exe Hardware Key Licensing Utility. 

haspds_windows.dll Hardware Key Licensing Library. 

Hinstall.exe Hardware Key Device Driver Installation Utility. 

ACLConfig.exe GUI to Tag Security Utility.  

Table 3 - Files Installed in "Common" Folder 

Licensing 
Most Matrikon OPC products require some form of licensing criteria be met to ensure that it 

functions successfully. 

The Matrikon OPC ODBC Client supports both software and hardware licensing. 

 

IMPORTANT TO NOTE:  

The following licensing information is described in detail within the Licensing Procedures 

document which accompanies the ODBC Client software and User’s Manual: 

 Requesting a software license 

 Enabling a temporary software authorization 

 Installing a permanent software license 

 Generating a new AuthorizeRequest.MTK file 

 De-licensing software 

 Installing a Hardware licensing 

 Licensing Q&A and Troubleshooting 

Note: De-licensing deactivates the transactions and re-licensing does not activate them. 

The user must activate them again, manually. 

 

 

IMPORTANT TO NOTE:  

De-licensing deactivates the transactions and re-licensing does not activate them. The 

user has to activate them again, manually. 

 



 

 MatrikonOPC Client for ODBC User’s Manual  25 

Contacting Support 
The Matrikon OPC Customer Services department (www.opcsupport.com) is available 24 hours a 

day, seven days a week.  

Contact Matrikon OPC Support using the information below, or send an email to 

(support@MatrikonOPC.com). For Monday to Friday daytime support requests, contact 

Matrikon OPC Support using the regional phone numbers provided in Table 4. 

 

Region Office Hours Contact Information 

North America 
  
UTC/GMT -7 hours (MST)  

8:00 am-5:00 pm +1-877-OPC-4-ALL 

South America  
  
UTC/GMT -3 hours (BRT)  

9:00 am-5:00pm +55 (11) 3475-1846 

Europe / Middle East /Africa *  
  
UTC/GMT +1 hours (CET)  

9:00 am-5:00 pm +49-221-969-77-10  
  

Australia/Asia *  
  
UTC/GMT +10 hours (AEST)  

9:00 am-5:00 pm +61-2-4908-2198  
  

* Toll-free regional numbers coming soon! 

Table 4 – Matrikon OPC Support Regional Contact Information 

 

For after-hours support in all regions, contact either of the following numbers. No extra charge is 

levied from Matrikon OPC for calling their after-hours support numbers. 

 

Region Contact Information 

All +1-780-231-9480 

Table 5 - After-Hours Support 

http://www.opcsupport.com/
mailto:support@MatrikonOPC.com
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Configuration 
The client GUI allows users to view and alter configuration parameters at run time. When a user 

views a configuration parameter, the information is retrieved and displayed. The updated 

parameters are sent as a group to the client when submitted.  

Minimal configuration of the MatrikonOPC Client for ODBC is required for the client to function 

properly, but users can customize the client’s behavior as required. This chapter shows users how 

to start and configure the client and describes each component in detail, including the windows, 

panels, and menu commands. 

The Starting the MatrikonOPC Client for ODBC section of this manual shows users how to start 

the software. The next sub-sections describe the Tool Tray Menu, Control Panel, and 

Configuration window, in detail.  

At the end of this section are four sub-sections that cover saving, clearing, and loading 

configuration settings, and shutting down the server. 

Starting the MatrikonOPC Client for ODBC 
Choose the appropriate shortcut from the Start menu to launch the MatrikonOPC Client for ODBC.  

Perform the following steps to start the MatrikonOPC Client for ODBC: 

1. Click the Windows Start button and select Programs -> Matrikon OPC -> OPC Client for 

ODBC, and choose OPC Client for ODBC. 

 By default, the client is installed as a Windows service. The client can be installed as a 

service during the installation process by selecting the Install as a service checkbox 

on the Select Features Screen (Figure 4) accessed via the Destination Folder 

screen (Figure 5). When the client is installed as a service, the splash screen does not 

appear, nor does the logo appear in the Tool Tray. Instead, the main Configuration 

window is immediately displayed. If the client is installed as a Windows service, users 

can also start it using the Service Control Manager applet (under the Windows 

Control Panel). 

 If the client is not installed as a Windows service, the server starts and the Matrikon 

logo  appears in the Tool Tray (Figure 11), located by default in the system tray. 

 

 

Figure 11 - Tool Tray 

 If the client is not installed as a Windows service, the Welcome screen appears 

briefly when the client starts up. 

 

Note:  

If the client is installed as a service, users can choose to run it as an application 

by re-registering the OPC server executable using the /REGSERVER command-

line switch. 

Tool Tray Menu 

 

Note:  

If the client is installed as a Windows service, the Tool Tray and Tool Tray 

Menu are not available. 



 

 MatrikonOPC Client for ODBC User’s Manual  27 

 

The Tool Tray Menu provides access to the Configuration window, and the About screen. It also 

contains the commands to shut down the server. 

 

Perform the following steps to view the Tool Tray menu: 

1. Right-click on the Matrikon logo . 

The Tool Tray menu appears (Figure 12). 

 

 

Figure 12 - Tool Tray Menu 

Table 6 describes the commands in the Tool Tray menu. 

Command Description 

Configure Displays the main Configuration window. 

Shutdown Shuts down the server. 

Table 6 - Tool Tray Menu Commands 

Configuration Window 

 

Note:  

If the client is installed as a Windows service, the Tool Tray Menu is not available. In this 

case, the Configuration window is then accessed via the Windows Start menu: Start -> 

Programs -> Matrikon OPC -> OPC Client for ODBC -> OPC Client for ODBC 

 

The Configuration window allows the user to configure database connections, table writes and 

custom writes. These operations will be discussed in depth later in this section. 

If the client runs as a local executable, it runs on the background despite the main configuration 

window being closed, even if no database transactions are configured.  

If the client runs as an NT service, it will run until it is manually shut down. Closing the main 

configuration window will shut down the configuration utility, but will not interfere with the normal 

operation of the client. 

Perform the following steps to view the Configuration window: 

1. Select Configure from the Tool Tray Menu or the Control Panel. 

The Configuration window (Figure 13) appears.  
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Figure 13 - Configuration Window 

Table 7 describes the commands in the main Configuration window. 

Command Description 

Main Menu Provides access to the File, Database, View, and Help menus. 

Main Toolbar Provides shortcut buttons for commonly performed operations. 

 Connect to Database…  
Launches the Database Connection Configuration window 

(Figure 14) to allow the user to configure the database connection. 

Configuration Overview 
Displays a tree of configured table writes. Right click on a 

component, to delete the component. 

Undo 
Undoes changes to a transaction. By selecting this option, the 

transaction is reverted to the last applied state. 

Apply 
Adds or updates the current transaction with the configuration 

specified in the GUI.  

 Delete  

Deletes the current database, transaction or OPC item from the 

configuration. When deleting a database, transaction or OPC item, 

note its position in the Current Overview tree. The deletion 

operation will delete the current tree leaf and every leaf below it.  

Table 7 - Configuration Window Commands 

The following sections describe the menus available from the Configuration window, and what 

they are used for. 

File Menu 

Table 8 describes the File menu commands. 
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Command Description 

New 
Clears the current configuration and starts a new one. The user is given the option to 

save the current configuration before clearing the existing one. 

Open 

Clears the current configuration and loads a new one from an existing file. Before 

clearing the old configuration, the user is prompted to save the current one. Displays 

the Open window to prompt for the file name. 

Save  

Saves the current configuration to an XML file. Displays the Save Configuration 

window to prompt for a new file name if the configuration is new and has not been 

saved before. 

Save As 
Saves the current configuration to an XML file. Displays the Save Configuration 

window to prompt for a new file name. 

Shutdown Shuts down the MatrikonOPC Client for ODBC and closes the Configuration window. 

Exit 

Closes the Configuration window. If the current configuration has not been saved, the 

user is prompted with the message “Save the configuration before closing?”. The 

MatrikonOPC Client for ODBC remains running in the background even after exiting 

the window. 

Table 8 - File Menu Commands 

Database Menu 

Table 9 describes the Database menu commands used to configure database connections and 

transactions. 

Command Description 

 Connect to Database 

Connects an ODBC data source to the client. Selecting Connect to 

Database will launch the Database Connection Configuration 

window (Figure 14). 

Table Write 

Begins configuring a new table write transaction for the selected 

database. This option is greyed out when the currently selected tree 

leaf is not a database. 

Custom Write 

Begins configuring a new custom write for the selected database. This 

option opens the Custom Write configuration window. The custom 

write option is greyed out when the currently selected tree leaf is not a 

database. 

Table 9 - Edit Menu Commands (Server Configuration) 

View Menu 

Table 10 describes the View menu command. 

Command Description 

 Options  

Displays the Preferences window which is described in detail in the 

section General Preferences of this manual. The Preferences window 

allows the user to configure General, Logging and Advanced options. 

Table 10 - View Menu Commands 
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Help Menu 

Table 11 describes the Help menu command. 

Command Description 

About 
Displays the Welcome screen, which includes information about the 

software version. 

Table 11 - Help Menu Commands 

MatrikonOPC Client for ODBC Configuration 
The MatrikonOPC Client for ODBC requires minimal configuration to setup OPC server and database 

communication. Communication between OPC servers and databases is defined by transactions. 

The term “transaction” refers to a mapping between a set of OPC items and a single database 

table. A configured transaction specifies how OPC item data is written to a database table, how 

database table information is written to OPC items or a combination of both.  

The MatrikonOPC Client for ODBC defines two types of transactions:  

 Table writes  

 Custom writes 

Both of which are discussed later in this manual. 

OPC Groups and Transaction Groups 

OPC servers use the concept of groups to define communication properties for a set of OPC items. 

When configuring a transaction, MatrikonOPC Client for ODBC will automatically create the 

necessary groups. However, transactions will assume several properties of these groups. These 

properties remain configurable. To fully utilize the MatrikonOPC Client for ODBC, it is necessary to 

have a basic understanding of how these properties affect the behavior of a transaction. 

The update rate for an OPC group defines the minimum time (in milliseconds) between updates for 

an OPC item. If this value is set too low, the OPC server will be over loaded trying to obtain fresh 

values from the device.  

 

Note:  

This value should never be set below 100 milliseconds. 

 

The I/O type refers to how data for items in this group will be retrieved from the OPC server. 

Communication with an OPC server may either be synchronous or asynchronous. When using 

synchronous communication, the OPC server polls the device for the values of OPC items. The 

frequency of this polling will be no lower than the group update rate. 

The asynchronous communication I/O type does not periodically poll the values of OPC data items. 

Rather, this communication type creates a subscription to each item in the OPC group. Whenever a 

subscribed item changes, the server reports the new values to the client. The number of changes 

reported is limited by the group update rate. If the value changes more than once during the 

update rate, only one of these values will be reported. 

The chosen I/O type affects how transactions are executed. If synchronous I/O is chosen, the 

transaction is executed for each OPC item once per polling period. If asynchronous I/O is chosen, a 

transaction will only be executed for an item when a change in data values is reported. 
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Connecting to a Database 

Before configuring a transaction, it is necessary to define a database connection. The database 

connection is configured in the Database Connection Configuration window (Figure 14). 

 

Figure 14 - Database Connection Configuration Window 

 

The Database Connection Configuration window components are described in Table 12. 

Command Description 

Database 

The name of the data source, which can be obtained from the ODBC “Data 

Sources” section in the Windows Control Panel. For more detailed 

information, refer to Appendix B - ODBC DSN Configuration. 

 

Select this button to refresh the Database list. This option is used to 

allow newly configured ODBC data sources to be shown in the Database 

dropdown. 

Configuration 

Selecting this button will access the ODBC Data Source Administrator 

window. This option provides the ability to configure new ODBC data 

sources. 

User Name 

The name of the user that the MatrikonOPC Client for ODBC must use to 

connect to the database.  

Note: This field is dependent upon the setup of the user database. If the 

database does not require authentication, then this field is left blank. 

Password 

The password for the above user name. 

Note: This field is dependent upon the setup of the user database. If the 

database does not require authentication, then this field is left blank. 

Timeout(s) 
The amount of time (in seconds) that the MatrikonOPC Client for ODBC 

must wait for the ODBC data source before declaring a timeout. 

Read Only 

Specifies whether the MatrikonOPC Client for ODBC is permitted only to 

read from the database (i.e., checkbox is selected), or if it can write as 

well (i.e., checkbox is cleared). 

Table 12 - Database Connection Configuration Window Components 
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Perform the following steps to define and connect to a database: 

1. Select the ODBC Configuration node in the Configuration Overview pane on the left, 

from the main Configuration window (Figure 13), choose one of these available options: 

 Click on the Connect to Database button in the Database Connection panel on 

the right side of the screen, or 

 Click on the Connect To Database icon on the toolbar, or 

 Select the Connect To Database menu option from the Database menu. 

The Database Connection Configuration window (Figure 14) is displayed. 

2. Select an ODBC data source from the Database drop-down list. 

3. Select the Configuration button to configure it without leaving the ODBC Client 

Configuration window if the desired ODBC data source is not configured, (refer to 

Appendix B - ODBC DSN Configuration) for more information. 

 

 

Note:  

Click the Configuration button (on the Database Connection Configuration window) 

to go to the ODBC Data Source Administrator screen where the user can create a data 

source configuration. Once the new ODBC data source configuration is finished, the user is 

returned to the Database Connection Configuration window, where the user MUST 

click on the Refresh ( ) button to refresh the list of available ODBC data sources. 

 

4. Enter the User Name and Password in the fields if a username and password is required 

for the database.  

5. Click the OK button to add the database. The Database Connection Configuration 

window closes.  

Removing a Database Connection 

Perform the following steps to remove/delete a database connection:  

1. Highlight the database the user wishes to remove from the Configuration window, in the 

Configuration Overview pane and perform one of the following actions: 

 Right click on the desired database icon in the Configuration Overview pane 

and select Delete (highlighted in red in Figure 15) from the displayed menu, or 

 Click on the Delete button (highlighted in blue in Figure 15) at the bottom right 

of the Configuration window, or 

 Click on the Delete icon  (highlighted in green in Figure 15) on the toolbar. 
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Figure 15 - Deleting Database Connection 

A confirmation message (Figure 16) appears asking the user to confirm the action and 

warning that deleting a database connection also deletes any table and custom writes 

configured for the database. 

 

 

Figure 16 - Database Deletion Confirmation Message 

2. Click the OK button. The confirmation message closes and the user is returned to the 

Configuration window and the selected database is no longer listed in the Configuration 

Overview pane. 

Creating a Transaction 

 

Note:  

Before creating a table write, a database connection must be configured. For assistance, 

refer to Connecting to a Database. 

 

Perform the following steps to create a transaction: 

1. Select the desired database node from the Configuration window in the Configuration 

Overview pane to create a Table Write for a database. 



 

 MatrikonOPC Client for ODBC User’s Manual  34 

The Transaction Configuration and Configuration Parameters screen sections are 

displayed in the right pane of the Configuration window (Figure 17). 

2. Create a Table Write or Custom Write transaction from this screen. 

 

 
Figure 17 - Table Write or Custom Write 

Table Writes 
Table writes are used to write attributes of an OPC item to a database table. The user selects a set 

of OPC items to be associated with each transaction. 

A table write may be classified as either an insert or an update. Both inserts and updates are 

analogous to their corresponding SQL operation. An insert transaction writes a new table entry to 

the database each time it is executed. An update transaction updates each entry in the database 

meeting the update criteria. A table write update will only update database entries with the same 

item name. Additionally, the user specifies to update database entries only if their quality matches 

to that of the current OPC item. The behavior of update transactions for this query is subtly 

different than SQL updates. There is one minor difference between an ODBC client update and an 

SQL update. For ODBC client updates where there are no table entries that match the update 

criteria, an entry with the new OPC item information is inserted into the database. 

Perform the following steps to launch the table write transaction configuration panel: 

1. Select the required database from the Configuration window, in the Configuration Overview 

pane (Figure 17). 

2. Click on the Table Write button, or select the Table Write menu option under the 

Database menu.  

The table write transaction configuration panel (Figure 18) is displayed. 
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Figure 18 - Table Write Transaction Configuration Panel 

 

The configuration panel components are described in Table 13. 

Command Description 

Transaction Name 
Allows the user to enter the name used to identify a transaction. 

When a transaction is first created, it is given a default name. 

Properties 

Click this button to access the Set Transaction Properties window 

which is used to define custom properties for the transaction. See 

Customize the OPC Specific Settings to view the window and for 

an explanation of these properties. 

Computer Name 

The name of the computer containing the OPC server. If applicable, 

this name includes the network path. This field can be entered 

manually, or populated using the Browse Servers command. 

OPC Server 
The ProgID for the OPC server. This field can be entered manually, or 

populated using the Browse Servers command. 

Browse Servers 

Use this button to browse for the OPC server to use with the 

transaction. OPC servers can be browsed on the local machine or, if 

applicable, the network neighborhood. 

OPC Items 
The OPC items for the transaction. This field can be entered manually, 

or populated using the Configure command. 

Configure Browse and select the OPC items involved in this transaction. 

Transaction Table The name of the table for the transaction. 
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Command Description 

 Refresh 
Click on this button to manually refresh the list of tables available 

from this database. 

Transaction Type Used to specify whether the transaction will be an insert or update. 

OPC Item Attribute 

to Database Column 

Mapping 

Used to specify the table columns where the Name, Value, Quality 

and Timestamp data are to be written. To be a validate Table Write, 

a column mapping must be chosen for at least one of the OPC item 

attributes. 

Table 13 - Table Write Transaction Configuration Panel Components 

Defining a Table Write 

A table write can be defined in as few as five steps, with two optional steps as described below. 

1. Choose a Transaction Name (Optional) 

Enter a name for the table write in the Transaction Name field. This name must be unique; it 

cannot match the name of other table or custom write transactions. By default, a unique name of 

the form Transaction_X, where X is a number, is generated when the query is created. 

2. Choose an OPC Server 

To browse the OPC server, click on the Browse Servers button to launch the Select OPC Server 

Connection window (Figure 19). 

 
Figure 19 - Select OPC Server Connection Window 

From the Select OPC Server Connection window, select a server from either a local or network 

machine. This option will automatically populate the Computer Name and OPC Server fields. 

Alternately, these names can be entered directly into these fields. 

Click on the OK button to close the Select OPC Server Connection window. 
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3. Choose OPC Items 

To browse OPC items, from the table write transaction configuration panel on the Configuration 

screen, click on the Configure button to display the Add OPC Item(s) window (Figure 20). 

 
Figure 20 - Add OPC Item(s) Window 

To instantiate a browse for the available items, click on Browse button on the Add OPC Item(s) 

window. This will launch the Browse OPC Item(s) window (Figure 21) containing the browsed 

items. 
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Figure 21 - Browse OPC Item(s) Window 

Multiple items are selected from the Browse OPC Item(s) window. Browsing items will populate 

the OPC Items field in the table write transaction configuration panel on the Configuration 

screen. Items are typed directly into the OPC Items field. If the server address space cannot be 

browsed, OPC items are entered manually. 

Select the item or items the user requires to add. 

Click on the Add Item button. The Browse OPC Item window closes and the user returns to the 

Add OPC Item(s) window where the selected item or items are now listed. 

Click on the OK button to close the Add OPC Item(s) window and returns the user to the 

Configuration window where the selected items are now listed in the OPC Items field. 

4. Choose a Transaction Table 

Select a table from the database to write to from the table write transaction configuration panel on 

the Configuration screen, in the Transaction Table field. If the name of the table is known, it 

can be typed directly into the Transaction Table field or the table can be selected from the drop-

down list.  
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Note:  

 Selecting the drop-down list may trigger the warning that it could take several 

minutes to load the table names. For many databases, this operation will take no 

more than a few seconds even though the warning appears. However, in some 

instances it may take several minutes to gather this information. This does not 

affect the operation of previously configured transactions. 

 The GUI will only re-load table information for a database if the user navigates 

away from the database or any of its configured transactions. In instances where 

loading the table names is a slow process, further delays can be avoided by 

configuring all desired transactions for a database before moving onto the next 

database. 

 

5. Choose a Transaction Type 

In the Transaction Type field on the table write transaction configuration panel, select whether 

the transaction should be an Insert or Update operation from the drop-down list. Note that 

choosing Update exposes the Update by Quality checkbox in the OPC Item Attribute to 

Database Column Mapping screen section. 

 

6. Choose an OPC Item Attribute to Database Column Mapping 

The OPC Item Attribute to Database Column Mapping screen section is used to specify which 

database columns the attributes of OPC items are written to in the database. For the OPC Name, 

Value, Quality and Timestamp attributes, the associated column is selected from a drop-down 

list of available columns for that table specified in the Transaction Table field. 

It is not necessary to map each attribute to a database column. However, only the mapped 

attributes will be written to the table. Each table write must define at least one attribute to column 

mapping. Additionally, more than one attribute cannot be mapped to the same table column. If the 

Transaction Type field is set to Update, the Update by Quality checkbox is displayed. To filter 

updates by quality, select that checkbox. 

 

7. Customize the OPC Specific Settings (Optional) 

To customize the transaction group properties, click on the Properties button next to the 

Transaction Name field (Figure 18) to display the Set Transaction Properties window (Figure 

22). A description of each of these options is presented in Table 14. 
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Figure 22 - Set Transaction Properties Window 

Table 14 describes the Set Transaction Properties window components. 

Command Description 

OPC Server Displays the ProgID for the OPC server. 

Machine 
Displays the machine and network information where the OPC server 

resides. 

Transaction Name 
The name of the current transaction. This name may be modified in 

this window. 

Update Rate(ms) 

The minimum update rate (in milliseconds) for the transaction group. 

This corresponds to the update rate for the OPC group containing each 

of the items in this transaction. 

%Deadband 

A value which is used for asynchronous communication to specify what 

constitutes a change in an OPC item. For example, a dead-band value 

of 10% means that the value must change by at least 10% to be 

considered a change. 

I/O Type 

Allows the user to specify (by selecting an option from the drop-down 

list) how data for items in this group will be retrieved from the OPC 

server. Selecting a synchronous type tells the client to make a request 

for data and wait until the server retrieves it. Selecting an 

asynchronous type means that the client makes a request for data, but 

does not wait for the server to retrieve the data. Rather, the server 

responds with an update only after retrieval, and only if item values in 

the group have changed.  

Note that each type in this drop-down list refers to an OPC 

communication standard. Not all standards may be implemented by 

the OPC server. Selecting Autodetect attempts to automatically 

choose the I/O type. Autodetect will attempt to choose an 

asynchronous type first, but will default to synchronous if this fails. 
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Command Description 

Time Bias(min) 

By default, OPC timestamps are based on UTC standard time. This field 

allows the user to select or enter a value to define a time bias that is 

to be used to convert this time to local time. The time bias specifies 

the number of minutes to subtract from UTC time. For example, a time 

bias of 420 means 420 minutes will be subtracted from the UTC time. 

Note: This field is disabled if the Auto Detect Time Bias checkbox 

has been selected. 

Queries/Transaction 

Advanced option to specify the number of SQL statements to bundle as 

a single SQL transaction for a MatrikonOPC Client for ODBC 

transaction.  

Auto-detect Time 

Bias 

Selecting this checkbox will result in the automatic calculation of the 

time bias setting based on the local settings of the local machine. 

Active This checkbox specifies if the transaction is active or inactive. 

Table 14 - Set Transaction Properties Window Components 

 

After completing these five steps (and two optional steps, if required), click on the Apply button to 

activate this transaction. A transaction cannot be executed until it has been applied. Figure 23 

shows a complete example transaction. 

 

Figure 23 - Configured Table Write 
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Deleting a Table Write 

Perform the following steps to remove/delete a table write: 

1. Select the transaction to delete in the Configuration Overview pane, and perform one of 

the following actions:  

 Right click on the item in the Configuration Overview pane and select Delete from 

the displayed menu, or 

 Click on the Delete button in the bottom right of the Configuration window, or 

 Click on the Delete icon  in the toolbar. 

Before deleting the transaction, a message (Figure 24) appears asking the user to confirm 

the deletion of the transaction. 

 

Figure 24 - Confirmation Message 

2. Click the OK button. The confirmation message closes. The user is returned to the 

Configuration window and the selected transaction is no longer listed in the 

Configuration Overview pane. 

Deleting a Transaction Tag 

Individual OPC items are deleted from a table write in different ways. 

Perform the following steps to remove/delete a transaction tag (Method 1): 

1. Select the transaction to delete a tag or tags from the Configuration window, in the 

Configuration Overview pane. 

2. Highlight those items to remove in the OPC Items field. 

3. Right-click and select either the Cut or Delete menu option from the displayed menu. 

The deleted items no longer appear in the OPC Items field. 

4. Click the Apply button to commit the change.  

Perform the following steps to remove/delete a transaction tag (Method 2): 

1. Select the transaction from which the user requires to delete a tag or tags in the 

Configuration Overview pane. 

The items associated with the selected transaction are listed below the transaction. 

2. Select the transaction tag to be deleted, and perform either of the actions:  

 Right click on the item and select Delete from the displayed menu, or 

 Click the Delete button on the bottom right of the Configuration window, or 

 Click the Delete icon  in the toolbar. 
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Before deleting the tag, a message (Figure 25) appears asking the user to confirm the 

deletion of the tag. 

 

Figure 25 - Confirmation Message 

3. Click the OK button. The confirmation message closes and the user is returned to the 

Configuration window and the selected tag is no longer listed in the Configuration 

Overview pane. 

Custom Writes 
Using table write transactions, simple insert and update transactions can be configured with a 

minimum amount of effort. In certain instances, more sophisticated data manipulation is required. 

The MatrikonOPC Client for ODBC is used to construct complex SQL statements using OPC item 

characteristics (name, value, timestamp or quality) and database table columns as parameters.  

Perform the following steps to launch the custom write editor: 

1. Ensure to create a database connection, described previously in the section Connecting 

to a Database.  

2. Highlight the database in the Configuration Overview pane for which the user is creating 

a custom write once the database connection has been established. The Configuration 

screen appears (Figure 17). 

3. Click the Custom Write (SQL) button, or select the Custom Write option from the 

Database menu to launch the custom write editor. The Add Query window (also referred 

to as the custom write editor) appears (Figure 26). 

The custom write editor is composed of two panes. The pane on the left (labelled Transaction 

Text) is where the SQL statements are entered. The right pane contains a series of tabs used to 

configure transaction options, display results of executed transactions, and display query results. 

The following sections explain the Add Query window tabs, and illustrate how custom writes are 

used by presenting examples. 

The Add Query window includes five tabs: 

 Data Values 

 Transaction Options 

 OPC Options 

 Transaction Results 

 Current Transactions 

Data Values Tab 

The Data Values tab is displayed in Figure 26. 
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Figure 26 - Add Query Window - Data Values Tab 

The options available in the Transaction Text panel are described in Table 15. These fields appear 

in this panel regardless of which tab is selected. 

Command Description 

Transaction Text Allows the user to enter the required SQL statements. 

Transaction Name Allows the user to enter the name used to identify this custom transaction. 

New Transaction 
Select this button to create a new blank custom query with a unique, 

automatically-generated name. 

Execute (F5) 

Select this button to execute the transaction displayed in the Transaction 

Text field. This option executes this custom transaction only once, and does 

not add it to the scheduled transactions for the client. Pressing the F5 key 

in the query editor will also execute the query. 

Table 15 - Add Query Window - Transaction Text Panel Components 

Table 16 describes the components of the Data Values tab. 

Command Description 

Database 
Use this drop-down list to choose which connected database for which to 

configure a custom write. 

Variable Name 

This table column is used to specify the names of variables entered in the 

Transaction Text pane. There will be a variable definition for each unique 

variable name. 

Variable Value This table column is used to specify the values of the variables 



 

 MatrikonOPC Client for ODBC User’s Manual  45 

Command Description 

corresponding to each variable name entered in the Transaction Text 

pane. There will be a variable definition for each unique variable name. 

Variable Declaration 

Syntax 

This pane provides a legend specifying how to define variables in 

statements entered in the Transaction Text window. This legend will 

change to match the start/end delimiters defined in the Transaction 

Options tab. 

Apply 
Select this button to accept any changes made in the Add Query window. 

Note: This button stays consistent across all tabs. 

Close 

Select this button to cancel any changes made and close the Add Query 

window. 

Note: This button stays consistent across all tabs. 

Table 16 - Add Query Window - Data Values Tab Components 

Transaction Options Tab 

The Transaction Options tab is displayed in Figure 27. The tab components are described in 

Table 17. 

 

Figure 27 - Add Query Window - Transaction Options Tab 
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Command Description 

Transaction Execution 

Options 

These options specify how the transaction is scheduled in the client. 

If the Execute Transaction When Values Arrive option button is 

selected, the transaction will be executed when new values are received for 

one or more of the associated OPC items. 

If the Execute Transaction At Time Interval option button is selected, 

the transaction will be scheduled to be executed at fixed intervals, 

regardless of whether or not any associated OPC item values have changed. 

This option should be used to ensure that transactions with no associated 

OPC items are executed. If this option is selected, the Transaction 

Frequency field is enabled. 

The Transaction Frequency field is available only if the Execute 

Transaction At Time Interval option button is selected. If enabled, this 

field allows the user to enter or select a value that specifies the frequency 

(in milliseconds) at which the transaction is executed. 

OPC Item Delimiters 

The Start Delimiter field allows the user to select from the drop-down list, 

the sequence of special characters used to delimit the beginning of an OPC 

item in a custom transaction. Values may either be chosen from the set { 

<<, {, {{, [, [[ }, or entered manually. If chosen from the set, the value 

for the end delimiter automatically matches this choice. 

The End Delimiter field allows the user to select from the drop-down list, 

the sequence of special characters used to delimit the end of an OPC item in 

a custom transaction. Values may be chosen from the set { >>, }, }}, ], 

]] }. If chosen from the set, the value for the start delimiter automatically 

matches this choice. 

Transaction Text 

Options 

Allows the user to select from the Text Size drop-down list, the size of the 

text displayed in the Transaction Text window. 

OPC Return Items 

When it is time to execute a transaction, there may be multiple values 

returned for an OPC item. 

Select the …write ALL the values to the OPC Item option button to 

execute the transaction for each value in the set. 

Select the …write ONLY THE LAST value returned option button to 

execute the transaction for only the most recent value in this set. 

Quotation Marks 
Allows the user to select which attribute or attributes are to be enclosed in 

quotation marks: Name, Value, Quality, Timestamp. 

Style 

Allows the user to select the option button that defines the automatic use of 

either single quotation marks (‘(Single Quote)) or double quotation marks 

(“(Double Quote)) for each of the selected attributes (see Quotation 

Marks). 

Apply 
Select this button to accept any changes made in the Add Query window. 

Note: This button stays consistent across all tabs. 

Close 

Select this button to cancel any changes made and close the Add Query 

window. 

Note: This button stays consistent across all tabs. 

Table 17 - Add Query Window - Transaction Options Tab 
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OPC Options Tab 

The OPC Options tab is displayed in Figure 28 and the tab components are described in Table 18. 

 

Figure 28 - Add Query Window - OPC Options Tab 

Command Description 

Update Rate (ms) 

Allows the user to enter or select the minimum update rate (in milliseconds) 

for the OPC group(s) associated with the transaction. This will be the 

minimum time between entries for an OPC item in the database. 

% Deadband 

Allows the user to enter or select a value which is used for asynchronous 

communication to specify what constitutes a change in an OPC item. For 

example, a deadband value of 10% means that the value must change by 

at least 10% to be considered a change. 

IO Type 

Allows the user to specify (by selecting an option from the drop-down list) 

how data for items in this group will be retrieved from the OPC server. 

Selecting a synchronous type tells the client to make a request for data and 

wait until the server retrieves it. Selecting an asynchronous type means 

that the client makes a request for data, but does not wait for the server to 

retrieve the data. Rather, the server responds with an update only after 

retrieval, and only if item values in the group have changed.  

Note that each type in this drop-down list refers to an OPC communication 

standard. Not all standards may be implemented by the OPC server. 

Selecting Autodetect attempts to automatically choose the I/O type. 

Autodetect will attempt to choose an asynchronous type first, but will 

default to synchronous if this fails. 

Time Bias By default, OPC timestamps are based on UTC standard time. This field 
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Command Description 

allows the user to select or enter a value to define a time bias that is to be 

used to convert this time to local time. The time bias specifies the number 

of minutes to subtract from UTC time. For example, a time bias of 420 

means 420 minutes will be subtracted from the UTC time. 

Note: This field is disabled if the Auto Detect Time Bias checkbox has 

been selected. 

Auto Detect Time Bias 

When this checkbox is selected, the time bias is automatically calculated 

based on the system time zone settings. 

Note: If this checkbox is selected, the Time Bias field is disabled. 

Apply 
Select this button to accept any changes made in the Add Query window. 

Note: This button stays consistent across all tabs. 

Close 

Select this button to cancel any changes made and close the Add Query 

window. 

Note: This button stays consistent across all tabs. 

Table 18 - Add Query Window - OPC Options Tab Components 

Transaction Results Tab 

The Transaction Results tab is displayed in Figure 29 and the tab components are described in 

Table 19. 

 

Figure 29 - Add Query Window - Transaction Results Tab 

Command Description 
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Command Description 

Results Grid 
Displays the Name, Quality, Value, and Timestamp results for the 

transaction. 

Result Status Displays the transaction query execution results.  

Clear Select this button to clear the tab. 

Apply 

Select this button to accept any changes made in the Add Query 

window. 

Note: This button stays consistent across all tabs. 

Close 

Select this button to cancel any changes made and close the Add 

Query window. 

Note: This button stays consistent across all tabs. 

Table 19 - Add Query Window - Transaction Results Tab Components 

Current Transactions Tab 

The Current Transactions tab is displayed in Figure 30 and the tab components are described in 

Table 20. 

 

Figure 30 - Add Query Window - Current Transactions Tab 
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Command Description 

Display 
This pane displays all current transactions and associated items. Select 

and expand the nodes to view and transactions. 

Refresh Click on this button to refresh the current view in the display. 

Apply 

Select this button to accept any changes made in the Add Query 

window. 

Note: This button stays consistent across all tabs. 

Close 

Select this button to cancel any changes made and close the Add 

Query window. 

Note: This button stays consistent across all tabs. 

Table 20 - Add Query Window - Current Transactions Tab Components 

Executing Simple Queries 

SELECT * FROM...  

The Add Query window can be used to execute SQL statements that do not involve OPC items or 

table column parameters. In the Transaction Text field, enter a simple select * from 

table_name. Ensure that the table table_name exists in the selected database (as shown on the 

Data Values tab). Next, press the Execute button or the F5 key to execute the query. Figure 31 

shows an example from a sample database containing a table named ExampleTable, with the 

columns TestName, TestValue, TestQuality and TestTimeStamp.  

 
Figure 31 - Simple Select Transaction Results 
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UPDATE...  

In the Transaction Text field, enter the following: update ExampleTable set TestValue = ‘55’ 

where TestValue = ‘0’.  

 

Figure 32 - Simple Update Statement 

Note that the Bucket Brigade.Int1, Bucket Brigade.Int2, Bucket Brigade.Int4 values that 

was previously 0 has changed to 55. 
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Figure 33 - Table ExampleTable after Update Statement 

The MatrikonOPC Client for ODBC can act as a query analyzer for the databases. The range of 

queries that can be executed by the client is limited only by the database that the user is trying to 

connect, and the ODBC driver that the user is trying to connect to the database. 

Using an OPC Item in a Transaction 

One of the most powerful features of custom writes is the ability to use OPC item attribute values 

as parameters for transactions. Each OPC item has four attributes: Name, Value, Quality, and 

Timestamp. The MatrikonOPC Client for ODBC defines a syntax allowing each of these attributes 

to be used in custom writes. 

The first step is to specify an OPC item variable. OPC item variables are declared inside of the SQL 

statement using two string delimiters. These delimiters are chosen from several pre-defined 

options. However, the default start and end delimiters are << and >>. Each example for custom 

writes will use the default delimiters. 

To specify an OPC item variable, the prefix i: is used. Based on the default delimiters, the 

declaration for a variable named itemname is: <<i:itemname>> 

To access the Name, Value, Quality, and Timestamp attributes of an OPC item, the suffixes .n, 

.v, .q, and .t respectively are used. Thus <<i:itemname>>.n is used to access the name 

attribute of item name. The following example illustrates how these can be used: 

1. Click on the Transaction Options tab from the Add Query window. 

2. Note which characters are being used to enclose an OPC item in the OPC Item Delimiters 

screen section. By default, the Start Delimiter is << and the End Delimiter is >>. 

Ensure that these delimiter values are selected. 

3. Enter <<i:itemname>> followed by a space in the Transaction Text field. 
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The pane on the right of the screen displays one row with itemname as an Argument 

Name, and a red Tag button adjacent to a blank field in the Argument Value column 

(Figure 34). 

 
Figure 34 - Syntax Example 

4. Click the Tag button. 

The Select OPC Item window appears.  

5. Use this window to browse the list of available servers and choose a tag to associate with 

the variable. 

6. Double-click the OPC item, set the Argument Value. The Tag button will turn green, and 

the field adjacent to the button is populated with the item name information as shown in 

Figure 35 - Successfully Assigned OPC Item. 

When a variable is properly declared in the Transaction Text pane, the start and end 

delimiters are highlighted. This can be seen in Figure 35 where the << and >> delimiters 

are both displayed in green. 
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Figure 35 - Successfully Assigned OPC Item 

Creating an Insert Transaction using an OPC Item  

The following example illustrates how to use OPC item variables in an SQL insert statement. For 

this example, create a database table named ExampleTable with four columns:  

1. TestName of type varchar. 

2. TestValue of the type associated with OPC item. 

3. TestQuality of type varchar or number. 

4. TestTimestamp of type datetime. 

Then perform the following steps to create the insert transaction: 

1. Enter the following string into the Transaction Text field:  

 insert into " ExampleTable "    

 values(<<i:item1>>.n,<<i:item1>>.v,<<i:item1>>.q,<<i:item1>>.t) 

 

Note:  

After entering the above string, the Add Query screen will appear as it does in Figure 

36. In the display, the variable delimiters will be highlighted in green, and SQL keywords 

highlighted in blue. 
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Figure 36 - Custom Write GUI - Insert Statement 

2. Select an OPC item that will provide the values for the transaction, to associate an OPC item 

with this transaction, following the procedure described in Using an OPC Item in a 

Transaction. 

3. Click the Apply button. This will schedule the transaction for execution based on the 

transaction execution option discussed in Transaction Options Tab.  

The GUI will switch to the Current Transactions tab. In this tab, the root node indicates 

the custom transaction name and each child node points to each individual transaction 

occurred in the query. 

Note the Current Transactions tab, after expanding each node in the tree, the transaction 

is displayed as shown in Figure 37. 
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Figure 37 - Custom Insert Transaction Display 

Write to OPC Items Using a Select Statement 

An SQL select statement can be used to write a value from a database to an SQL item. Database 

column variables are declared using a slightly different syntax. Instead of i:, the syntax c: is used 

to specify that the variable refers to a column. The only OPC attribute used for the table column 

custom writes is the value. Thus, table column variables do not have an attribute suffix associate 

with them. 

Using ExampleTable as our database table, an example transaction using a table column variable 

is as follows. Enter the following into the Transaction Text field on the screen:  

select <<c:TestValue>> from ExampleTable where TagName = ‘BucketBrigade.Int2’ 
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Figure 38 - Select Statement Example 

Like transactions using OPC item variables, a tag must be chosen for this transaction. Click on the 

red Tag button to browse the available servers, and select a tag from one of these servers. This 

chooses the tag that is to receive database column information. The above example may return 

more than one value to be written to the selected OPC item. Depending on the options selected, 

the client will either write only the latest value returned, or each of the values returned. 

 

Note:  

Ensure that the transaction is scheduled to execute. By default, custom writes are 

scheduled to execute whenever a change in the associated OPC item is detected. If this 

transaction was scheduled in that manner, it would only be executed whenever an 

external source modified the OPC item. It is unlikely that this is the desired behavior. 

Such a schedule should be scheduled to execute at fixed intervals. This can be done on 

the Transaction Options tab. 

 

General Preferences 

The Preferences window is used to configure basic client behavior, logging and performance 

settings. This window is accessed by choosing the Options menu item from the View menu. This 

window consists of three tabs: 

 General 

 Logging 

 Advanced 
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General Tab 

The General tab (Figure 39) allows the user to customize configuration files, and how quality 

values are reported. The General tab components are described in Table 21. 

 

Figure 39 - Preferences Window - General Tab 

Command Description 

Save current 

configuration on 

shutdown 

Selecting this option specifies that the ODBC client should save its 

current configuration whenever the client is shutdown. This option 

refers to the shutdown of the entire client, not just the configuration 

GUI. The configuration is saved to the file name displayed in the 

textbox shown in Figure 39. 

Note: This option is only applied after the ODBC client restarts. 

Load this 

configuration on 

startup 

Selecting this checkbox enables the text field and Browse button 

below the checkbox, allowing the user to select and load the ODBC 

configuration file when the client starts up. 

Browse 

Click on this button to display the Open window to select an existing 

file name. For this button to be enabled, the Load this configuration 

on startup checkbox must be selected. 

OK 

Selecting this button commits any changes made in the Preferences 

window and closes the window. 

Note: This button stays consistent across all tabs. 

Cancel 
Selecting this button cancels any changes made in this window. 

Note: This button stays consistent across all tabs. 
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Command Description 

Apply 
Selecting this button commits any changes made in the window. 

Note: This button stays consistent across all tabs. 

Table 21 - Preferences Window - General Tab Components 

Logging Tab 

The Logging tab (Figure 40) allows the user to customize error and debug information. The tab 

components are described in Table 22. 

 

Figure 40 - Preferences Window - Logging Tab 

 

Command Description 

Minimum log file size 
This option cannot be changed. 500 KB is the minimum default log file 

size. 

Maximum log file 

size 

Sets the maximum log file size before logs will wrap. 

Log Level 
Sets the general logging activity logging at the specified detail level 

(High, Medium, Low, or None). 

Log File Name Displays the full path for the general activity log file. 

Browse 
Click on the Browse button to display the Open window used to select 

an existing file name. 

Commit all log file Purges the file buffer after each message is logged in the event of an 



 

 MatrikonOPC Client for ODBC User’s Manual  60 

Command Description 

writes unexpected server shut down. 

Overwrite old log 

information 

Overwrites the old log file each time the server starts up, if selected. 

Otherwise, rename the old log file with a (*.bak) suffix. 

OK 

Selecting this button commits any changes made in the Preferences 

window and closes the window. 

Note: This button stays consistent across all tabs. 

Cancel 
Selecting this button cancels any changes made in this window. 

Note: This button stays consistent across all tabs. 

Apply 
Selecting this button commits any changes made in the window. 

Note: This button stays consistent across all tabs. 

Table 22 - Preferences Window - Logging Tab Components 

Advanced Tab 

The Advanced tab (Figure 41) is used to define the request queue settings. The tab components 

are described in Table 23. 

 

Figure 41 - Preferences Window - Advanced Tab 

 

Command Description 

Maximum Requests 

Queued 

Allows the user to specify the maximum number of ODBC Client 

transactions that can be queued. Setting this value to 0 means that there is 
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Command Description 

no maximum value for the queue size. 

Interval to Report 

Discarded Requests 

Allows the user to specify how often to report discarded transactions in the 

log file. Consider a value of n for this field. When the number of discarded 

transactions reaches a multiple of n the total number of processed and 

discarded transactions is logged. Note that this only occurs if logging is 

enabled. 

OK 

Selecting this button commits any changes made in the Preferences 

window and closes the window. 

Note: This button stays consistent across all tabs. 

Cancel 
Selecting this button cancels any changes made in this window. 

Note: This button stays consistent across all tabs. 

Apply 
Selecting this button commits any changes made in the window. 

Note: This button stays consistent across all tabs. 

Table 23 - Preferences Window - Advanced Tab Components 

Saving a Configuration 

 

Note:  

When the client configuration is complete, use the Save Configuration window to save 

the configuration to an XML file. 

 

Perform the following steps to save a configuration to an XML file: 

1. Select the Save As menu option from the File menu. 

The Save Configuration window appears. 

2. Enter a file name if the file is saved for the first time. 

3. Click Save. 

The configuration is saved. 

Clearing a Configuration 

 

Note:  

Starting a new configuration will clear the existing one. 

Perform the following steps to clear a configuration: 

1. Choose the New menu option from the File menu.  

2. The user will be prompted with a message “Do you want to save the configuration?”, select 

Yes to save the configuration, No to clear without saving, and Cancel to retain the current 

configuration. 

If the user has not selected Cancel, the configuration is cleared. 
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Loading an Existing Configuration 

 

Note:  

If the user has previously saved a configuration, the current configuration can be cleared 

and then load the saved configuration file. 

 

Perform the following step to load an existing configuration file: 

1. Select the Open menu option from the File menu. 

The Open Configuration window appears. 

2. Browse for the configuration file that the user wants to load. 

3. Click Open. 

4. Click OK. 

The old configuration is cleared and the new configuration is loaded from the file. 

Shutting Down the Server 
 

 

Note:  

The MatrikonOPC Client for ODBC will run until a shutdown has been requested. 

 

Perform the following steps to shut down the server: 

1. Select Shutdown on the Control Panel or the Tool Tray Menu. If the server is running as 

a local executable, choose Shutdown Server from the File menu or right-click the 

MatrikonOPC Client for ODBC icon and select shutdown.  

The server is shut down. 

 

 

Note:  

The shutdown command is not available for the server if it runs as a Windows service. 

Services can be shut down only from the Service Control Manager applet in the 

Windows Control Panel. 
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Diagnostics 
The server supplies diagnostic information to assist operators and support personnel with 

troubleshooting communication problems and software faults. 

Logging 
All Matrikon OPC servers produce log files that record errors and debugging information. The log 

files can be extremely valuable for troubleshooting. As such, it is important to note that the default 

log level is set to low. The General Logging tab of the Options dialogue in the main configuration 

window contains settings to control server logging. 

General Activity Logging records information about the internal workings of the OPC server. It is 

useful for troubleshooting problems with configuration and device communication. Interface 

Activity Logging records information about the client/server OPC communication. It is useful for 

troubleshooting compliance issues.  

For General logging, the higher the log level, the more information that is recorded. However, 

server performance may decrease at higher log levels. The recommended operating level is 

Medium. More log levels are available for both types of logging which record more detailed 

information, as well as the ability to output log statements to a console window at run time. 

Contact Matrikon OPC support for further instructions on how to enable the higher log levels and 

console logging. 

For Interface logging, the log level can be considered very high and therefore should never be used 

during normal operation of the OPC server unless specifically working on problems related to 

interfacing. 

Matrikon OPC Sniffer is a useful tool for logging OPC client/server communication. It enhances 

the Interface Activity Logging by recording the client-side transactions. It can also be used with 

other OPC servers. Matrikon OPC Sniffer is a utility used to troubleshoot OPC client/server 

interoperability issues. Contact the Matrikon OPC Sales department for further information about 

this product, or use the following link to access the Matrikon Sniffer Download. 

In general, the server logs all errors and other information of immediate importance to the user at 

the low detail level, all warnings and other information of moderate importance to the user at a 

medium detail level, and additional information concerning the normal functioning of the software 

at a high detail level. The server also logs further information of concern to support personnel at 

the debug log level. 

 

Note:  

The higher the log level, the slower the performance of the server. It is recommended 

that the log level be left at the default, unless troubleshooting needs to be performed. 

 

 

 

 

 

 

http://www.matrikonopc.com/downloads/179/productsoftware/index.aspx
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Limitations 
MatrikonOPC Client for ODBC has the following limitations: 

1. Table Writes for Oracle - do not support the TimeStamp<> syntax required by Oracle 

databases. For Oracle ODBC data sources, table write functionality can be configured as a 

custom write. 

2. Stored Procedure and Triggered Write Configuration – customers who upgrade from 

the old version to the new version of ODBC Client should note that the new GUI does not 

allow Triggered Writes and Stored Procedures to be configured graphically.  

3. Display for legacy configuration files – the new GUI of this client does not display each 

of the transaction types from the previous version of the client. Triggered Writes and Stored 

procedures are not displayed in the new GUI, and the OPC item to table column mappings 

will not show up in the new GUI.  

4. Custom Write Variable – the custom variable c: syntax does not allow the variable name 

to contain the ‘[‘ or ‘]’ characters.For example, the variable name <<c:[ColumnName]>> 

is not valid. Rather, <<c:ColumnName>> should be used. One side effect of this limitation 

is that users may not use column names with spaces for c: variables, as they must be 

delimited using ‘[‘ and ‘]’. 

 

Refer to the MatrikonOPC Client for ODBC Release Notes for known issues. 
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Troubleshooting 
The following section addresses some of the most common problems encountered, and questions 

asked, while using this OPC server. Please check the following Problems/Solutions and 

Questions/Answers sections before contacting the Matrikon OPC Support team. 

Problems and Solutions 

Client cannot be configured; no Matrikon logo in Tool Tray 

 

Problem: The client cannot be configured because there is no Matrikon logo  in the Tool 

Tray. 

Solution: If the client is running as a service, the Matrikon logo  does not appear in the Tool 

Tray.  

To configure the client, start the configuration utility by using the shortcut to the OPC 

server in the Windows Start menu (this shortcut starts the Configuration utility as 

well as the OPC Server). 

Registered ODBC data sources not visible from the configuration GUI 

 

Problem: When connecting to a database, a registered ODBC data source does not appear in the 

dropdown list. 

Solution: ODBC data sources must be registered as either a system, file or user DSN. If the data 

source is registered as a user DSN, it may be necessary to execute the client as that 

user. If the client runs as a service, make sure the service is set to execute as the 

appropriate user. 

Server does not retain settings 

 

Problem: The client does not retain its previous settings and needs to be reconfigured each time 

it starts up. 

Solution: In the Configuration window, choose Options from the View menu. Under the 

General tab, ensure that the Load this configuration on start-up checkbox is 

selected and that the correct file name appears in the edit box. 

Server cannot save configuration in XML format 

 

Problem: The OPC client cannot save the configuration in XML format. 

Solution: Microsoft Internet Explorer 4.01 (or later) must be installed to use the .XML format. 

Server does not show up as remote program in OPC client application 

 

Problem: The OPC server I wish to connect to, does not show up in a list of remotely available 

program IDs in the client application. 

Solution: Follow the steps found in Appendix A – Distributed COM (DCOM) to copy the 
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program ID from the server machine to the client machine. 

Access denied or time-out error when connecting to remove server via DCOM 

 

Problem: Access Denied error message appears, or time out occurs when trying to connect to 

a remote OPC server via DCOM. 

Solution: 
Ensure that the access and launch permissions for the OPC server are set correctly on 

the server machine. For more information, refer to Appendix A – Distributed COM 

(DCOM). 

Server does not start up or client cannot connect 

 

Problem: The client tries to connect to the server and fails, or the server does not start up. 

Solution: Ensure that the access and launch permissions for the OPC server are set correctly. 

For more information, refer to Appendix A – Distributed COM (DCOM). 

About screen and Configuration window do not show up 

 

Problem: The About screen and Configuration window do not show up when a remotely 

connecting client or a client that runs as a service (such as the Aspen Technologies 

CIMIO OPC Manager) tries to launch the OPC server. 

Solution: Either set the identity for the OPC server to the interactive user, or consider running 

the server as a service. For more information, refer to Appendix A – Distributed 

COM (DCOM). 

DA 2.05 asynchronous I/O does not work 

 

Problem: After installing an older OPC server, DA 2.05 asynchronous I/O no longer works. 

Solution: The old installation program installed and registered its own (older) version of the OPC 

proxy/stub DLL.  

Reinstall the standard OPC proxy/stub DLLs, using an up-to-date installation program 

or re-register them using the REGSVR32 command-line utility. 

Questions and Answers 

How do I remove the server as a service?  

 

Problem: How do I remove the client as a service? 

Solution: Re-register the OPC server executable using the /REGSERVER command-line switch. 

How can I get OPC data into other applications? 

 

Problem: How can I get OPC data into Microsoft Excel, Microsoft Word, or another application 

with support for Visual Basic, VBA, or VB Script? 
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Solution: Use the Matrikon OPC Automation Component to create a Visual Basic script that 

connects to a server, creates groups and items, and receives data change updates. 

Contact Support for examples of how to do this in Excel, Visual Basic, or an HTML 

document. 

 

Search the Matrikon OPC Support Knowledge Base at www.opcsupport.com to find the answers 

to other commonly-asked MatrikonOPC Client for ODBC questions. 

http://www.opcsupport.com/
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Un-Installation 
To successfully un-install MatrikonOPC Client for ODBC, using the Add or Remove Programs from 

the Microsoft Windows Control Panel is recommended.  

Perform the following steps to un-install MatrikonOPC Client for ODBC: 

1. Click the Start button and highlight the Control Panel item. 

2. Select Programs and Features from the displayed menu.  

The Uninstall or change a program window is displayed. 

3. Scroll through the list of currently installed programs and updates to find and select 

MatrikonOPC Client for ODBC (Figure 42). 

 

Figure 42 – Programs and Features 

4. Click the Uninstall button associated with the MatrikonOPC Client for ODBC program to 

initiate the un-install process.  

The MatrikonOPC Client for ODBC– InstallAware Wizard appears, and the Welcome to 

MatrikonOPC Client for ODBC Maintenance screen (Figure 43) is displayed.  
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Figure 43 – MatrikonOPC Client for ODBC Maintenance Screen 

5. Select the Remove option button to un-install MatrikonOPC Client for ODBC entirely.  

6. Click the Next button. The Ready to Uninstall screen (Figure 44) is displayed.  
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Figure 44 – Ready to Uninstall Screen 

7. Click the Next button.  

The Uninstalling MatrikonOPC Client for ODBC screen (Figure 45) appears and the un-

install takes place.  
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Figure 45 – Uninstalling MatrikonOPC Client for ODBC Screen 

When the un-install has finished, the MatrikonOPC Client for ODBC Setup Complete 

screen (Figure 46) appears stating that MatrikonOPC Client for ODBC was successfully un-

installed.  
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Figure 46 – MatrikonOPC Client for ODBC Setup Complete Screen 

8. Click the Finish button to complete the un-install and exit the Wizard.  

The program no longer appears listed in the Programs and Features window. 
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OPC Compliance 
For more information on OPC, view the documents listed below (as well as other OPC 

Specifications) at http://www.opcfoundation.org. The MatrikonOPC Client for ODBC can 

connect to OPC servers that implement the following interfaces: 

 OPC Data Access Custom Interface Standard 2.05 

 

 

http://www.opcfoundation.org/
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Appendix A Distributed COM (DCOM) 
DCOM is an object protocol that enables COM components (such as OPC clients and servers) to 

communicate directly with each other across a network. A certain amount of configuration is 

required on the system where the OPC server is installed to allow remote clients to connect to it 

over the network. 

Readers should be familiar with DCOM and with Windows 2000 security features and security 

administration. Information regarding Distributed COM and various links to related sites, white 

papers, specifications, and so on, can be found at: 

http://www.microsoft.com/com/default.mspx. 

 

Note:  

 The following steps are suggestions only. Enquire with the Windows Network 

Administrator for more information about the settings that the user should use, 

especially between different domains. 

 The steps provided in this appendix apply to Windows NT operating systems only. 

For information on how to configure DCOM settings for newer Windows operating 

systems, Refer to the Matrikon OPC Online Support page on DCOM Settings. 

DCOM Configuration Utility 
Start the DCOM configuration utility either from the server configuration utility or from the 

command-line (DCOMCNFG). Answer, yes to any message boxes that appear (allowing the utility to 

assign application ID entries to those servers that don't already have them). 

The main window for DCOMCNFG allows the user to either configure default settings for all COM 

servers or else to configure settings for a specific server chosen from the list. The former will affect 

all servers configured to use the default settings. The latter will affect the selected server only. 

 

Note:  

DCOM settings are stored in the registry and loaded by COM (and OPC) servers at start-

up. Therefore, server processes must be shut down and re-started for these changes to 

take effect. 

Default Properties 
The Default Properties tab contains settings that affect all DCOM communication on the machine. 

 Ensure to select the Enable Distributed COM on this computer so that the machine 

is available to others via DCOM.  

 Select the Enable COM Internet Services on this computer to allow DCOM access to 

the machine from the Internet (check with the administrator).  

 In general, the other settings do not need to be changed. 

 

The Authentication Level specifies when COM should authenticate the identity of calling clients 

(each call, each packet, etc).  

 Normally, it should be set to Connect, indicating that COM should authenticate clients 

when they first connect to a server. If it is set to None, then COM performs no 

authentication and ignores any access permission settings. 

 

http://www.microsoft.com/com/default.mspx
http://opcsupport.com/ics/support/default.asp?deptID=4590&task=knowledge&questionID=71
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The Impersonation Level specifies if servers can ascertain the identity of calling clients and if it 

performs operations on the client's behalf (as if the server is the client).  

 Normally, it should be set to Identify, allowing the server to identify the calling client to 

see if it is allowed access to a certain resource but not to access any of these resources 

as the client. 

 Select the Provide additional security for reference tracking to make even the 

reference counting on COM objects secure. This setting is not generally required. 

Security Permissions 
The most important DCOM settings for an OPC server are the security permissions. There are two 

ways for the user to set these: 

1. Change the specific settings for the server (recommended).  

2. Change the default settings (not recommended) and make sure that the OPC server will use 

these. 

Either way, ensure that the access and launch permissions are correct for the server. 

Setting Security Permissions 

Perform the following steps to set the security permissions for an OPC Server: 

1. Open the DCOM configuration utility. 

2. Select the OPC server, and then click Properties. 

The Distributed COM Configuration Properties window (Figure 47) appears. 



 

 MatrikonOPC Client for ODBC User’s Manual  76 

 
Figure 47 - Distributed COM Configuration Properties Window 

3. Click on the Security tab to set the security for the server. 

The Distributed COM Configuration Security tab (Figure 48) appears. 
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Figure 48 - Distributed COM Configuration Security Tab 

  

 

Note:  

 The Access Permissions contain an Access Control List of principals that can 

interact with objects supplied by a server. 

 The Launch Permissions contain an Access Control List of principals that can 

start up a server process or service. 

 

4. Include the names of users or user groups from trusted domains that can use the OPC 

server on this machine. Include the Everyone group to allow access to all users on a 

specific domain. 

5. Click Use custom access permissions and then click Edit to set the Access permissions. 

The Registry Value Permissions window (Figure 49) appears. 
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Figure 49 - Registry Value Permissions Window 

6. Click Add to add users to the list. 

The Add Users and Groups window (Figure 50) appears. 

 
Figure 50 - Add Users and Groups Window 

7. Select the user, and click Add to add a user to the list. If the username, the user requires 

to add does not appear then click Show Users. 
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8. Click OK to close the Add Users and Groups window once the user is done adding users. 

The user then chooses to Allow Access or Deny Access for each user. 

 

 

Note:  

 The procedure to set the launch permissions is like the above, but instead of 

choosing Allow Access the user must choose Allow Launch. 

 The Configuration Permissions contain an Access Control List of principals that can 

modify the configuration information for a server. In other words, it indicates who 

can alter the registry entries for installed servers as well as who can access the 

registry for the purposes of installing new servers. It is usually simpler to install 

and configure servers as a user with local administrative rights. 

 

9. Create a local user account on both the server and the client machine with identical 

username and password to connect to an OPC server from outside of the domain. Then, add 

the local user on the OPC server to the DCOM permissions. Use the local account on the 

client machine to connect to the OPC server. 

Server Identity 
The Identity tab for a selected COM (or OPC) server specifies the user account that should be 

used when COM starts up the process. The available settings are different for servers that run as 

local executables as opposed to those that run as NT services. 

 

Note:  

It is strongly recommended that OPC servers should be installed to run as NT services if 

they are going to be accessed by remote clients via DCOM. This ensures that the server 

can always be accessed even if no one is presently logged on to the machine, and only 

one server process ever starts up. It also adds more security in terms of who can shut 

down the server process. 

 

Servers that run as local executables have the option of running as the launching user (the calling 

client–this is the default), the interactive user (the one currently logged onto the machine), or a 

specified user. It is usually best to use the interactive user or a specified user. Otherwise, remote 

clients might start up multiple separate server processes that are not accessible to others. 

Servers that run as NT services should generally run as the local System account. Alternatively, 

the server can be set to run as a specified user, although this is usually done from the Service 

Control Manager applet rather than DCOMCNFG. Access and Launch permissions are particularly 

important when installing a server to run as an NT service. 

Default Protocols 
The Default Protocols tab specifies the communication protocols available to DCOM. The order 

that protocols appear in the list indicates the priority in which they will be used (the topmost 

having the highest priority). 

The more protocols that appear in the list, better are the chances of connecting to an OPC server 

on an unknown remote machine (such as at an OPC Interoperability Workshop). However, it may 

also take longer for DCOM to time out if a server machine is not present since it must try each 

protocol in turn. 
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For most situations, it is best to remove all unused protocols from the list and only include those 

that are necessary for the network. For example, on a TCP/IP network, one would include the 

Connection-oriented TCP/IP protocol. Contact the IT personnel for more information about the 

network.  

 

Note:  

Evidence indicates that there are problems with the datagram-oriented protocols (such as 

UDP/IP) that can cause memory leaks in DCOM. Therefore, it is strongly recommended 

that these protocols be removed from the list of default protocols. Datagram-oriented 

protocols are not supported under Windows 2000 at all (although the DCOM configuration 

utility still allows the user to configure them). 

Remote Program ID 
Before the OPC Server Browser became available, OPC client applications had to search the 

registry to generate a list of available OPC servers. Therefore, some older OPC clients need to have 

a program ID in the local registry to connect to an OPC server. 

The simplest solution is to install the OPC server software on the client machine even if it is not 

used. Alternatively, use the following steps to copy a program ID to the client machine. 

 

Note:  

This method may not work for every OPC client. Refer to the client documentation for 

more information. 

 

 

WARNING: 

 Any changes made to the registry must be made with extreme caution! 

 

1. Back up the registry. 

2. Run REGEDIT as a user that has access rights to the local registry on the server machine. 

3. Expand the HKEY_CLASSES_ROOT key. 

4. Find the program ID(s) for the desired OPC server(s).  

 

 

Note:  

In the case of Matrikon OPC Servers, the ID has the form Matrikon.OPC.Device. If the user 

quickly types the first few letters, then REGEDIT should jump to the location of that key. 

Some servers may have both a version-specific as well as a version-independent program 

ID. In this case both IDs should be copied to the client machine. 

5. Select the key and choose Export Registry File from the Registry menu. For each 

program ID, Enter a file name, and then click Save. Ensure not to overwrite other export 

files that is created. 

6. Copy the exported REG files to the client machine. 

7. Merge the REG files into the registry of the client machine.  
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Note:  

Double clicking on the file from the desktop of the client machine. Alternatively, run 

REGEDIT on the client machine and choose Import Registry File from the Registry 

menu, selecting each file in turn. This must be done as a user who has write access to the 

local registry. 

8. Use REGEDIT to check that the program IDs have in fact, been copied. 

9. Delete the REG files since they are no longer needed. 
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Appendix B ODBC DSN Configuration 
This section provides the user with step-by-step instructions on how to properly configure the OPC 

server to connect with the sample Microsoft Access database supplied.  

DSN Types Note 
Microsoft Windows supports the configuration of three types of ODBC data sources: 

1. System: A registered data source that can be used by any user of the system. 

2. User DSN: A data source defined for a specific user. 

3. File DSN: A data source intended for use by multiple users on potentially different machines. 

These DSN settings are saved in a file with a .DSN extension. 

Data Source Configuration  
 

 

Note:  

The MatrikonOPC Client for ODBC communicates with databases that are registered as 

ODBC data sources. An example for registering a database as a system DSN is presented 

below. 

 

1. Select Control Panel -> Administrative Tools -> Data Sources (ODBC) from the Start 

button, or select the configuration tool right from the MatrikonOPC Client for ODBC by 

clicking Configure on the Database Connection Configuration Window as shown in 

Figure 51. 

 

 

Figure 51 - ODBC Data Source Administration Screen Access Path 

The ODBC Data Source Administrator screen appears.  

2. Select the System DSN tab (Figure 52). 
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Figure 52 - ODBC Data Source Administrator (System DSN Tab) 

3. Click the Add button.  

The Create New Data Source window (Figure 53) appears.  

 

 
Figure 53 - Create New Data Source Window 
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4. Select the driver for the data source. The sample that is provided uses the Microsoft Access 

driver, if the user is connecting to an Oracle database ensure the user uses the driver 

provided by the Oracle Client tools installation and not the Microsoft ODBC for Oracle driver. 

Select that option from the list.  

5. Click the Finish button.  

 The ODBC Microsoft Access Setup window (Figure 54) appears.  

 

 
 Figure 54 - ODBC Microsoft Access Setup Window  

6. Enter TestDatabase in the Name field to configure the name of the DSN.  

 

 

Note:  

This name can be anything, however, the configuration file that is Data Source included 

with this installation assumes that the user will name the DSN as TestDatabase. 

 

7. Click the Select button.  

 The Select Database window (Figure 55) appears.  

8. Browse to the OPC server installation directory path and select the SampleDB.mdb file.  
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Figure 55 - Select Database Window 

9. Click the OK button to close the Select Database window and return to the ODBC 

Microsoft Access Setup window.  

10. Click the OK button to finish the DSN configuration from the ODBC Microsoft Access 

Setup window. 

11. TestDatabase should now appear in the list of system DSNs (Figure 56) that the user notices 

in the ODBC Data Source Administrator window.  

 

 
Figure 56 - List of System DSNs 
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Note:  

If the user has moved the database location, the user must update the DSN information, 

or else error 11616 will occur. Refer to the Release Notes to read about the bug. 

 


